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SU Podium V2 is a photo-realistic rendering software program that is a plug-in to Google SketchUp 7 or 8. Podium
employs ray tracing and global illumination to create photo-realistic images. Ray tracing simulates the path of a ray of light
as it would be absorbed or reflected by various SketchUp textures or faces. Global Illumination or GI is an algorithm that
takes into account not only the light which comes directly from a light source like Sky Light or the Sun, but also subsequent
cases in which light rays from the same source are reflected by other faces in the scene (indirect illumination). SU Podium
V2's GI is far superior to previous versions of Podium. For more information about Ray tracing and GI, please read about it
in Wikipedia.org

A. Operating SU Podium V2
System Requirements for the Mac and for Windows requires SketchUp 7 or 8. Mac version will require OS-X 10.5 or
above. The V2 engine is multi-threaded meaning it will take advantage of all your CPU core's. You also need a reasonable
amount of RAM to hold 3d scene data. The more RAM you have, the more complex models you can render. However,
currently SU Podium V2 is a 32 bit application. Therefore any RAM above 4 gigabytes will not be used.

1. Install

The install process is straight forward and in most cases will require no input from the user.

Windows Install for SketchUp 7 and 8. You must have a Windows Administrator User Account to install SU
Podium V2. You can run the program without being an administrator but to install it you must be have administrative

http://www.suplugins.com/help-faq-v2.php


privileges. Close SketchUp before starting the install. Double click on the install file you have downloaded. An
installation program will start. The default install location for SU Podium V2 is \program files\google\google sketchup
7\plugins\. Change this location to ..\google sketchup 8\plugins\ if you are installing for SketchUp 8. If you have a 64
bit Windows operating system, the default location will be \program files (x86)\google\google sketchup 7\plugins\.
The installation will create a sub-folder in the \google sketchup 7 (or 8)\plugins\ folder called SU_Podium_V2. There
will also be a ruby load file in the plugins folder called SU_Podium_V2.rbs and the Podium Light System ruby script
called plsv2.rbs. If you need to uninstall SU Podium V2, use the Uninstall option from the All Programs ---->SU
Podium V2 location.

Mac Install for SketchUp 7. Close SketchUp before starting the install program. Double click on the
SU_Podium_V2_SU7_Mac.zip file that you downloaded. This will unzip the install file. Double click on the install,
package file. SU Podium V2 is installed in the MacIntosh HD\Library\Application Support\Google SketchUp
7\SketchUp\Plugins\. A new folder in the Plugins directory called SU_Podium_V2 is created as well as a ruby load
file called SU_Podium_V2.rbs and the Podium Light System ruby script called plsv2.rbs. If you need to uninstall SU
Podium V2, move the SU_Podium_V2.rbs, plsv2.rbs and SU_Podium_V2 folder into the trash bin.

Mac Install for SketchUp 8. Make sure you purchase or upgrade the SU Podium V2 for SketchUp 8. This only works
on SketchUp 8. Close SketchUp before starting the install program. Double click on the
SU_Podium_V2_SU8_Mac.zip file that you downloaded. This will unzip the install file. Double click on the install,
package file. SU Podium V2 is installed in the MacIntosh HD\Library\Application Support\Google SketchUp
8\SketchUp\Plugins\. A new folder in the Plugins directory called SU_Podium_V2 is created as well as a ruby load
file called SU_Podium_V2.rbs and the Podium Light System ruby script called plsv2.rbs. If you need to uninstall SU
Podium V2, move the SU_Podium_V2.rbs, plsv2.rbs and SU_Podium_V2 folder into the trash bin.

Sixteen alpha numeric number to enter If you are using the commercial version of SU Podium, after click on
rendering and before the Podium Render Process or OOPR begins, you will prompted for a 16 digit alpha-numeric
serial number that you received after purchasing or upgrading to SU Podium V2. Click here for any problems with
serial number entry.

2. Render process and getting started
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After installing SU Podium V2 for Google SketchUp 7 or 8, you can access SU Podium V2 from the SketchUp plug-ins pull
down menu or from the SU Podium V2 tool bar. You can run both the older version SU Podium 1.x and SU Podium V2
during the same SketchUp session.

If you are not familiar with V2 already, to get started, open a relatively small SketchUp model that you want to render.
Alternatively, download and open this simple model which has already been setup with V2 reflection and light properties.



Download pdmv2_sample.skp.

To introduce V2's rendering process, do a quick render of your model. First click on the Options menu from the pull down
or the tool bar. In the preset pull down list, pick Default.pps. In the Output tab, under Dimensions, pick a Fixed size or the
default Viewport size for the rendered image size. Click the OK button. Then pick the Render menu from the pull-down or
tool bar.

The first thing Podium V2 does is Process Scene. Once that is complete, the Podium Render Manager or OOPR will launch.
If you do not see see the Podium Render Manager dialog box pop-up, click on OOPR from the Task Bar in Windows or
Dock in the Mac.

If you are using the full version and this is the first time rendering, before OOPR launchs, you will asked to enter a 16 digit
serial number.

Once the Podium Render Manager (OOPR) is launched, V2 will go through several rendering steps. The last two steps are
Raytracing and Resampling Edges (anti-aliasing). You can click on the Preview menu in the Podium Render Manager to
view the render progress dynamically. As a default, the rendered image will be saved to the folder that the SketchUp model
is saved in unless you change the location for saved images to be saved in.

3. Download and test some ready made SketchUp models.

Click on this link to go to the SU Podium V2 models page. You can do download five render ready SketchUp models to test
results.

4. Where to get Support

The following Help pages will guide you through Installation and using and applying SU Podium. Please take a moment and
read through the Installation chapter if you are having difficulty with the install. If you are having trouble finding your serial
number, please take a look at the FAQ section of this web site. There is a detailed description of how to find your serial

http://www.su-podium.com/v2beta/pdmv2_sample.skp
http://www.suplugins.com/models.php


number. In addition, you can get support from the following areas:

The SU Podium Forum - an active Forum with two or three experts online almost any time.
E-mail support Please e-mail us with any question, any time. You should get a reply within 24 hours. Usually, much
faster.
Upload your models. If you are having problems rendering your models, feel free to upload them to our box.net
account. Make sure you send and e-mail to us to let us know you have uploaded a model. Upload your model here -
Upload to Box.net
FAQ section

 

B. Apply Material Properties
Click here to watch the material properties video tutorial.
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Don't forget to click on Apply for properties to take effect

Reflections, refractions, bump maps, LEM lights and other properties are applied to a specific texture globally in the model.
This is one major difference from Podium 1.X where reflections and lights are applied to a SketchUp face.

Select a SketchUp texture you want to apply Podium properties too. You can select the texture by selecting the face that the
texture is on or you can select the texture directly from the SketchUp Material browser. When you make a texture selection,
its name will appear at the top of the Podium Material Property dialog box.

(Please Note: Textures that are assigned to curved surfaces or back side of faces, should be selected from the SketchUp
Material browser or with the i-dropper icon. These textures will not automatically appear in the V2 material editor. Please
see known issues below. )

http://www.websitetoolbox.com/tool/mb/supodiumforum
mailto:support@cadalog-inc.com
mailto:support@cadalog-inc.com
https://www.box.net/drop/Podium16/15e2926ed9
http://www.suplugins.com/help-faq-v2.php
http://www.suplugins.com/help-videos.php#v2-2


Once a selection is made, apply the various Podium properties to the texture by using the appropriate slider. This will turn
the texture into a Podium material.

Please Note: You must click on the Apply button for the properties to be applied to the material.

Diffuse, Transparency and Reflections are connected to each other. The combined value of the three sliders should equal
100% when applied to a texture. The default setting for non-transparent materials is 100% diffuse. However, if you want to
see direct reflections on that texture, move the Reflection slider to the right. The Diffuse slider will automatically move left.
Diffuse is reflection that does not bounce directly back to the camera but reflects at an angle. An example of the difference
between Diffuse and direct reflection might be the reflection of a paved road. When it is dry, it has more diffuse reflection.
When it is wet, it has more direct reflections. You can not have 100% Reflection (direct) and 100% Diffuse. Otherwise the
material will render strangely.

Transparency is the SketchUp transparency/ opacity property conveniently located here. It is not wise to have a high
transparency and a high reflection value. That is not real world and you renderings will look odd. The rule of thumb is to
combine the 3 sliders to make 100%.

Refraction is where light waves "bend" when passing through a material with a refractive index. A good example of this is a
straw placed at an angle in a glass of water. The water has a refractive index of 1.33. The straw looks bent at the surface of
the water. Although there is no such material as air in Podium, if there was it would have a refractive index of 1. Version 2
has a list of preset refractive indexes for certain materials. To use Refraction on a texture, select the texture and enter a
refractive index. Check out a good explanation of refraction here - Wikipedia

Both Reflections and Refractions have a blur option. The render speed will slow down if you choose the blur option but the
reflections will look very realistic.

Bump Depth slider will allow you to apply bump maps to textures. Bump values are different to V1.x, and a value of 1
produces an extremely subtle effect suitable for water.

http://en.wikipedia.org/wiki/Refraction


The Light slider in the material properties will apply LEM (Light Emitting Material) to the texture you have selected. LEM
lights are one type of artificial light source in SU Podium V2 and will create lights that emit light in one direction away
from the face of the texture. LEM lights are easy to create and are quick to render. Light slider is the LEM light slider. Pick
a texture and apply the light slider. This will turn that texture into a LEM Light. You can pick a value from 1 to 100. The
values must be whole numbers.

High Intensity check box is applied to the LEM Light. When High Intensity is on, single digit power values should be used.
Otherwise the LEM light will be extremely bright. In most cases, you will not need the High Intensity option.

See more about artificial and natural lights below in section C.

C. Lights
Back to TOC

1. Sky Light, Sun Light - Natural Lights

Click here to watch the natural light tutorial video.

SU Podium V2 has two types of natural lights. Sky and Sun. These are both "exterior" lights but can have great influence on
interior renderings if your models have openings to the exterior such as windows and doors.

Sky light is an ambient, exterior and uniform light source being emitted from the "sky". It is analogues to an overcast day
where the sunlight is hidden. Sky light is always on. However, if you have interior designs with no openings to the exterior,
sky light will be shut out.

Sky light brightness is controlled by a variety of variables. One is the preset you choose from the Preset list in the Options
menu. Another is whether you use SketchUp Sky or Podium's Physical Sky, also selected from the Options menu in the
Environment section. If you have selected SketchUp Sky, SketchUp's background colors will control the sky light's
brightness. If you have selected Podium's Sky or Physical Sky, SketchUp background colors will be ignored. Rather the time
of day will be an important factor in sky light color and brightness.

Sun light is another source of natural light. Sun light is only on when SketchUp Shadows are on. The sun's brightness and
exposure are controlled by a number of variables:

http://www.suplugins.com/help-videos.php#v2-3


Presets from the Preset list in the Options menu
Sun intensity and exposure sliders
Time of day, time of year, location and position relative to North-South-East-West
SketchUp Sky or Physical Sky

But don't be intimidated by these variables. Simply try rendering with Shadows on and look at the effect. Then make
adjustments.

2. Artificial Lights - LEM, Omni's and spot lights.

Click here to watch the artificial light tutorial video.
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a. LEM Light

The Light slider in the material properties menu will apply LEM (Light Emitting Material) to the specific texture you have
selected. LEM lights are one type of artificial light source in SU Podium V2 and will create lights that emit light in one
direction away from the face of the texture. LEM lights are easy to create and are quick to render. Light slider is the LEM
light slider. Pick a texture and apply the light slider. This will turn that texture into a LEM Light. You can pick a value from
1 to 100. The values must be whole numbers.

High Intensity check box is applied to the LEM Light. When High Intensity is on, single digit power values should be used.
Otherwise the LEM light will be extremely bright. In most cases, you will not need the High Intensity option.

Note: Unlike Podium 1.X, V2 will apply Podium properties globally to textures.If you select a certain texture to have light,
every surface in the entire model with that texture applied will emit light.

b. Omni Lights/ Point lights

Click here to watch the artificial light tutorial video.

Omni light or Point light (name is used interchangeably in this document) is an artificial light source which emits light
uniformly in all directions, similar to a light bulb. To insert an omni light or point light, click on the point light icon in the

http://www.suplugins.com/help-videos.php#v2-4
http://www.suplugins.com/help-videos.php#v2-4


toolbar and drag an omni light into the model. The omni light/ point light is a SketchUp group called a light group. You can
see the light group in SketchUp's outliner.

c. Omni light Light power/ color control

It's easy to adjust light power and color now. Just pick the Point Light and use this UI to make changes. For LEMs, select
the material with the SketchUp texture i-dropper and adjust the slider in the Podium Material Properties dialog box. For
omni lights, click on the Light Properties icon in the toolbar, select the omni light and you can adjust the strength and color
from the dialog.

d. Soft omni lights option

As a default, omni lights/ point lights have "hard" shadows meaning the edge of the shadow cast by the omni light is hard.
There is a soft shadow option that makes the omni lights look more natural. This option is accessed from the Options menu
in the Environment tab. There is a significant render speed cost when using this option.



soft omni shadows off, 2 min 18 sec at viewport rez soft omni shadows on, 4 min at viewport rez

3. Spot Lights

Click here to watch the spot light tutorial video.

Spot lights are a type of omni light. However, spot lights have a different user interface and always have soft omni lights on.
The SU Podium V2 pull down menu includes Podium Light System V2 which is an option to use Spotlights. Read the Please
read about Spot Lights in the Podium Light System information here

D. Options Menu
Click here to watch the Introduction to V2 video which explains the user interface in detail.
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The Options menu has important settings that allow you to choose presets, resolution size for the rendered image, image file
format (JPG/PNG/HDR), transparent, where to save your rendered images and various Environment settings such as
Physical Sky vs SketchUp Sky, sun exposure and intensity, caustic, clay and soft omni lights.

http://www.suplugins.com/help-videos.php#v2-5
http://www.suplugins.com/pls.php
http://www.suplugins.com/pls.php
http://www.suplugins.com/help-videos.php#v2-1


1. Presets

There are several presets that have been crafted for certain rendering environments. Presets were created to control hidden
variables that effect things like Physical Sky’s turbidity, sun brightness and contrast, ray trace bounces, amount of ambient
light, tone mapping variables, anti-aliasing, etc.

The presets are saved in the Preset folder in the SU Podium V2 folder. Presets can be opened and edited with a text editor if
you know what you are doing.

This document does not describe how to edit the presets. If you do desire to edit the presets, visit the Podium Forum and join
a discussion about presets. Presets have a file extensions of .pps. This means that your Windows Explorer or Mac OS may
confuse the preset file for a PowerPoint file. Make sure you open a preset with a text editor like Notepad.

The fastest raytracing preset is default.

Interior presets. Currently there are two. The interior presets have increased levels of sun brightness. The best use of the
interior presets are with interior models that have openings to the exterior such as windows or sky lights. Sun light and sky
light will be enhance using the interiors using these presets.

Exterior presets. Exterior presets are made for exterior renderings.

If presets confuse you, simply use the default preset and adjust the sun light with SketchUp sky color, time of day and the
intensity/ exposure slider.

2. Resolution size and image formats

Back to TOC

The full version will have Fixed sizes and Custom sizes for resolution. The trial version has limited resolution sizes.
Viewport resolution means the rendered image is restricted to your SketchUp viewport resolution size. In other words, the
image resolution will match the pixel size of your SketchUp viewport. For example, if you have a 1600 X 900 computer
screen and the SketchUp viewport is full screen, then your rendered image resolution will be close to 1600 X 900.

The choice of resolutions sizes include Fixed sizes or custom sizes. Fixed sizes are 230X150, 640X480, 1024X768,
2048X1536, 3076X2304, 4076X3304, Wide screen resolutions of 852X480, 1600X900, 1920X1080. Custom sizes mean that
you can enter any pixel height and width such as 8000 X 5000.

SU Podium V2 gives you the option to choose PNG/JPG/HDR as saved image formats. You can save your images to a
folder of your choice if you choose Custom. Currently there is no Browse button for Custom. You must key in the folder
location or cut and paste it from Windows Explorer.

3. Transparent

With the PNG format on, Transparent will create rendered images with alpha transparent backgrounds so that you can easily



add your own sky background image to rendered .png file in an image editor program. Click Here for more detail on
Transparent backgrounds

4. Environment settings

The Environment tab gives you access to several global settings.

a. Default (set in SketchUp) will use SketchUp background color and/or SketchUp Sky settings (set in your SketchUp Style)
for the rendered image's background colors.

b. Sky or Physical Sky. Physical Sky is a setting where Podium calculates and displays Sky turbidity (haziness caused by
particles suspended in the atmosphere) and depth. Physical Sky will ignore the SketchUp background colors but rather is
controlled by the preset variables, time day and year, location. Physical Sky will only be on when SketchUp Shadows are
on.

Note: When your SketchUp shadows are on, Sun light is on regardless of what background option has been selected.

c. Sun Intensity and Exposure sliders in Environment settings

Sun intensity and exposure sliders in the Environment settings. Move sliders to the left and the rendered images will have
less Sun exposure or intensity. The opposite effect will be true if you move the sliders to the right. Rest will reset the slide
values to the original state.

d. Clay is where textures are ignored and the entire model is rendered in the default, front face color of SketchUp - like a
clay model.

e. Caustic will apply a caustic effect to transparent materials, globally. Colored light through colored glass is not
implemented yet.

f. Soft omni lights is a global setting for omni or point lights. The default setting is for this option to be checked off.
However, if you want soft shadows to be applied to omni lights to create a natural lighting effect, turn this on. Soft Omni
Lights is discussed in more detail in Section C.

E. Render and Preview
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Before rendering, you may want to check the Options menu, to see where the rendered image will be saved and to look at
other settings. As a default, the rendered image will be saved to the same folder that your SketchUp model is in. However,
the rendered image can be saved in a folder of your choice. There is no browse button to find the folder of your choice. You
must key in the address to save the images.

To start the rendering process, click on the Render icon from the Tool bar..

Once the rendering process is invoked, you can preview the rendering progress by picking the Preview menu in the Podium
Render Manager UI (OOPR)..

F. Podium::render
A function that will invoke Podium's rendering from a Ruby script or from the Ruby Console is included in V2. The
command is Podium::render.

Known Issues
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Also check the FAQ page for the latest summary of Frequently Asked Questions and Known Issues/ Bugs

1. Support for large or complex models. Even with the Podium Rendering Manager models that are larger than 800,000 faces
may crash. Limitations on memory use means that some models will not render because the system will run out of RAM.
We will be working on a 64 bit version of Podium V2.

2. There is a know issue with User Account names and SketchUp file names. If your Windows User Account has a double-
byte name (such as Japanese, Chinese or Korean) the textures will not get rendered. Please see Trouble Shooting area for
more detail. If your SketchUp file name has a double-byte name (such as Japanese, Chinese or Korean), the rendering
process will get interrupted. Change your file name to single byte characters.

3. The rendered results are dependent upon the preset chosen. Some presets are configured for different types of scene and
will produce strange results on others. You may need to experiment to find the best preset. These will evolve over time and
more will be introduced before release.

4. Podium V1.x lights will not work in V2 due to differences in the way the 2 render engines work. The V2 light fixture
library is available now. Download from the download page.

5. Blurred reflection and refraction, will slow down the rendering process.

http://www.suplugins.com/help-faq-v2.php


6. Colored transparent surfaces do not cast colored light.

7. If you select a texture that is on a curved surface, the texture's name will not appear in the Material Property dialog box.
Select that specific texture from SketchUp's Material browser or use the SketchUp material selection (eyedropper) tool. This
is true for textures that are on a back side (reverse side) of a SketchUp face as well.

8. Edit Texture from within SketchUp. If you edit a SketchUp texture from inside SketchUp and then render, the rendered
images displays the original texture and not the edited texture. You will need to delete the contents of the Podium textures
folder.

Window users - Go to C:\Users\(your user name)\AppData\Local\Temp\SU_Podium_V2\textures\

Mac users - You will need this script to access the TMPDIR. Download the OpenTMPDIR script here. . Open
this zip file and launch the OpenTMPDIR script. This will display the Temp folder inside Finder. Go to the
SU_Podium_V2 folder and then to Textures. Delete all the image files in this textures folder. Then render.

9. There are more than one bugs with rendering of textures.

10. Help and FAQ links are not connected in the pull-down menu.

Finally, there are additional features planned for release (or subsequent s) which aren't implemented yet.

Troubleshooting
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